
 CARTOONS AND POP ART: User Guide 

CARTOONS AND POP ART 
 

Actions for Adobe® Photoshop® Elements 11 or newer 

 

 

 

 

 

 

User Guide 



 CARTOONS AND POP ART: User Guide 

 

 

CONTENTS 

1. THE BASICS .............................................................................................................................................. 1 

1.1. About the effects .......................................................................................................................................... 1 

1.2. How the actions are organized ..................................................................................................................... 1 

1.3. Installing the actions in Photoshop .............................................................................................................. 2 

2. BEFORE RUNNING THE ACTIONS ............................................................................................................... 2 

2.1. Selecting the right photos ............................................................................................................................ 2 

2.2. Photos with transparency ............................................................................................................................ 3 

3. THE ACTIONS ........................................................................................................................................... 4 

3.1. Optimal image size ....................................................................................................................................... 4 

3.2. Three different cartoons .............................................................................................................................. 4 

3.3. The layers: .................................................................................................................................................... 5 

3.4. The “Dots pattern” action ............................................................................................................................ 6 

3.5. The “Speech Balloons” ................................................................................................................................. 7 

3.6. The “Pop Art” effects .................................................................................................................................. 10 

1. CARICATURES......................................................................................................................................... 18 

1.1. Turning a face into a caricature .................................................................................................................. 18 

  



 CARTOONS AND POP ART: User Guide 

  1 

© Panos Efstathiadis | all rights reserved 

1. THE BASICS 

1.1. About the effects 
The “Cartoons and Pop Art” is a set of Photoshop actions, which you can use to turn your photos into beautiful 

cartoons. The effects also include various elegant speech balloons, as well as pop art backgrounds and collages. 

 

1.2. How the actions are organized 
The actions are grouped in 4 groups, within the “PFx CARTOONS 

and POP ART pse” set: 

 

 The first group contains the core action, called the 

“Cartoonizer”. 

 

 The second group is called “SPICE IT UP”. It contains 2 

actions that let you add a halftone pattern and create a 

grayscale copy of the cartoon. 

 

 The third group contains 16 actions, which let you add 16 

speech balloons to the cartoon. 

 

 The actions in the fourth group let you spice up the 

cartoons with beautiful pop art effects. To use these 

actions, you will need to cartoonize a photo with a 

transparent background (e.g. a person or an animal 

extracted from the background). 
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1.3. Installing the actions in Photoshop 
If you don’t know how to install and use Photoshop actions, please refer to this article on PanosFX.com: 

https://www.panosfx.com/installation-troubleshooting/installing-pse-actions  

 

 

2. BEFORE RUNNING THE ACTIONS 

2.1. Selecting the right photos 
Not all photos are appropriate for these effects. To create a beautiful cartoon, prefer photos that meet these 

standards: 

 

Prefer photos of people (or animals, objects) taken from a short distance. Face portraits make great cartoons! 

 

 

Avoid photos taken under poor lighting conditions or photos taken under ‘hard’ light. 

 

 

Avoid blurred photos! 
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2.2. Photos with transparency 
One of the advantages of the “Cartoonizer” actions is that you can use them on photos with transparency (such as 

a layered PSD photo with transparency, or a PNG-24 photo with transparency). The actions will preserve any 

transparent pixels. 

So, what’s the big deal about using a photo with transparent background?  

If your photo has a transparent background, you can use the actions in the “POP ART TOUCHES” group to create 

various pop art inspired effects. For example, you can insert a sunburst type of background behind the cartoon. 

You can extract a person / animal / object from its background using the “Quick Selection Tool”: 

   

We will refer to the pop art effects later in this manual. 
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3. THE ACTIONS 

3.1. Optimal image size 
 

The action produces best results with photos whose size is in the range from 3 to 8 Megapixels.  

When the action begins, it lets you change the size of the photo. If your photo is very big (or very small) try to set 

its longest side (width or height) to ~2500 pixels. As a general rule, enter a value from 1500 to 3500 pixels for the 

longest image side. 

 

3.2. Three different cartoons 
The “Cartoonizer” action creates three different cartoons on your work area, so that you to choose the one you 

prefer mostly. The first cartoon is richer in details; the second has a flatter look, while the third one looks glossier 

with fewer sketch lines. 
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3.3. The layers: 
The “Cartoonizer” action creates 3 layers that are combined to create the overall effect.  

At the bottom of the layers stack you can find two more layers: 

the “Original Photo” and the “Background”. Both layers are 

turned off.  

You can compare the original image vs. its cartoon version, by 

holding down the Alt key (Mac: option) and clicking on the small 

eyeball icon to the left of the “Original Photo” layer. 
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3.4. The “Dots pattern” action 
Having created the cartoon using the “Cartoonizer” action, you can now add a halftone pattern using the “Dots 

pattern” action. 

 

The action will open the Halftone Pattern filter settings. Move 

the Size slider to your liking and hit OK to apply your changes: 

 

 

 

 

 

 

 

A new layer called “Dots Pattern” has been created on the layers 

panel. You can change its opacity and / or its blending mode, or 

even delete it. 

 

 

 

  



 CARTOONS AND POP ART: User Guide 

  7 

© Panos Efstathiadis | all rights reserved 

3.5. The “Speech Balloons” 
The actions in the “SPEECH BALLONS” group let you add 16 different vector speech balloons, to the cartoon. You 

can run the same action as many times as you wish, to add multiple balloons of the same type. 

 

To resize the balloon, hold down the SHIFT key and drag a handle: 
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Use the corner handles to rotate the balloon. When you hover the 

mouse over a corner handle it will be transformed into a double-

headed curved arrow. Click and drag to rotate, double click to confirm, 

press Esc to cancel. 

 

 

 

 

 

You can also right click on the balloon, and 

select the two “Flip” commands to flip the 

balloon horizontally and/or vertically: 
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How to change the balloon color: 

With the balloon layer selected, select the menu command “Layer > New Fill Layer > Solid Color”. 

Change the layer name to “Balloon color”; check the “Use Previous Layer to Create Clipping Mask” box; set the 

Mode to “Multiply” and hit OK: 

 

Pick a color of your preference and hit OK. 

  



 CARTOONS AND POP ART: User Guide 

  10 

© Panos Efstathiadis | all rights reserved 

3.6. The “Pop Art” effects 
To use the actions in the fourth group (“POP ART TOUCHES”) you need to have a photo where the photographic 

object has been extracted from its background: 

To extract an object from the background, pick the Quick Selection Tool:  

 

Carefully select the background. To subtract pixels from the selection, hold down the Alt key (Mac: option) while 

clicking. Press the bracket keys [ ] to change the size of the selection brush tip. 

Having selected the background, hold down the Alt key (Mac: option) and click 

the Add a mask icon, at the top of the layers panel: 

This will mask out the background: 

   

TIP: To fine-tune the selection, hold down Shift and select the menu command Select > Refine Mask. This will open the 

“Refine Mask” window. 

 

Now run the “Cartoonizer” action. 
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The action completes and the photo is turned into a cartoon:  

 

The action preserved the transparent background pixels. It’s time to use the 4 pop art actions. 
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The “Collage (4 photos)” action. 

The “Collage (4 photos)” action will turn the cartoon into a pop art collage, which shows 4 different versions of 

the photo, placed over colored tiles: 

 

You can easily change the colors of each one of the 4 tiles, by double clicking the respective color fill layer in the 

layers panel. 
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The “Collage (9 photos)” action. 

The “Collage (9 photos)” action will turn the cartoon into a pop art collage, with 9 different versions of the photo: 

 

You can easily change the colors of each one of the 9 tiles, by double clicking the respective color fill layer in the 

layers panel. 
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The “Sunburst background” actions 

This action places a sunburst graphic behind the cartoon:

 

 

There are two “Sunburst” actions. Each action produces 3 different backgrounds, with customizable colors (2 x 3 = 

6 different backgrounds).  
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The 6 “Sunburst” backgrounds 
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The “Halftone background” action. 

This action places a halftone pattern graphic behind the cartoon:

 

The action lets you select the two pattern colors (default: red & yellow) and define the maximum dot radius. 

When the action completes, a layer group called “Halftone background” is created in PSE 2018 or PSE 15. It 

contains 2 layers: “Color 1” and “Color 2”. Click on the layer thumbnails, to change the colors to your preference: 

In PSE 14 (and in the older PSE versions) the action creates 2 layers, called “Halftone – Color 1” and “Halftone – 

Color 2”. Double click their thumbnails, to change the default colors to your preference.  
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The 2 “Halftone” backgrounds 
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1. CARICATURES 

1.1. Turning a face into a caricature 
Adobe introduced the facial feature adjustments in Photoshop 

Elements 15. You can use this amazing technology to turn one or 

more faces into caricatures, prior to using the Cartoons actions.  

You need to have a photo showing at least one human face, 

which is facing forwards. Select Enhance > Adjust Facial Features 

from the menu. Use the settings on the right, to modify the facial 

features.  

Adjust the settings and press OK to apply. Repeat as many times 

as you wish, to create a funny face. Finally run the Cartoon action. 
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If you have any questions, please use the contact form at panosfx.com 

 

Panos Efstathiadis 

www.PanosFX.com 

 

     

 

 

 

 

 

 

The photos used in this guide were kindly provided by Shutterstock. The Shutterstock IDs are as follows: 

 

140378221.jpg 

 

 

169057235.jpg 

 

136789808.jpg 

   

 


